Compilation of PHITS using the free Intel Fortran compiler

(OneAPI toolkits)

Phase I: Install Visual Studio IDE (integrated development environment)

I-1

Search “visual studio” or go to https://visualstudio.microsoft.com/

(¢] @ docs.microsoft.com/en-us/visualstudio/releases/2019/release-notes 2 % 4 » 0O o :
. . . -
What's New in Visual Studio 2019
»d Visual Studio 2019 version
6! Fitsr by:ttls I Visual Studio 2019 version 16.11.15
“ Visual Studio 16‘11 Re ease NOtes Visual Studio 2019 version 16.11.14

Article + 05/18/2022 + 28 minutes to read Visual Studio 2019 version 16.11.13

G
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Visual Studio Roadmap

Release Rhythm Show more Vv

What's New In Visual Studio Docs .
Q Tip
> Visual Studio 2022
v Visual Studio 2019 Watch the recordings of the Visual Studio 2022 launch event to learn

Current Release Notes about what's new, hear tips & tricks, and download free digital swag.

Distributable Code
Platform Compatibility Developer Community & | System Requirements | Compatibility | Distributable Code
| License Terms & | Blogs & | Latest Release Known Issues® | Whats New in Visual

System Requirements .
Studio Docs

Visual Studio 2019 Roadmap
Product Lifecycle and Servicing Click a button to download the latest version of Visual Studio 2019. For instructions
Release and Build History on installing and updating Visual Studio 2019, see the Update Visual Studio 2019 to

. the most recent release. Also, see instructions on how to install offline.
License Terms &

> Visual Studio 2017 - H Download Community 2019 L | Download Professional 2019 &
[l Download PDF Download Enterprise 2019

I-2

Download “Visual Studio Community 2019”

Note : In April 2022, OneAPI and Visual Studio Community/professional/enterprise 2022
are incompatible. Please don’t select 2022 unless the latest OneAPI solves this compatibility

problem.

I-3

Install “Visual Studio Community 2019” using the downloaded installer.

In the window below, please tick “Desktop development with C++". It says C++ while PHITS
is Fortran, but this is OK.

Then click the right bottom button to start installation.



Modifying — Visual Studio Community 2019 — 16.11.15

Workloads  Individual components  Language packs

Web & Cloud (4)

@ ASPNET and web development
Build web applications using ASP.NET Core, ASP.NET,
HTML/JavaScript, and Containers including Docker supp...

Python development
Editing, debugging, interactive development and source
control for Python.

Desktop & Mobile (5)

NET desktop development
Build WPF, Windows Forms, and console applications
using C#, Visual Basic, and F# with .NET and .NET Frame...

m M Uuniversal Windows Platform development @
reate applications for the Universal Windows Platform

ol . lications for the Universal Windows Platf
with C#, VB, or optionally C++

Location
C:\Program Files (x86)\Microsoft Visual Studio\2019\Community

Installation locations

Azure development
Azure SDKs, tools, and projects for developing cloud apps
and creating resources using .NET and .NET Framework.

Nodes development
Build scalable network applications using Nodejs, an
asynchronous event-driven JavaScript runtime.

Desktop development with C++
Build modern C++ apps for Windows using tools of your
choice, including MSVC, Clang, CMake, or MSBuild.

Mobile development with .NET
Build cross-platform applications for iOS, Android or
Windows using Xamarin.

By continuing, you agree to the license for the Visual Studio edition you selected. We also offer the ability to download other software with Visual

Studio. This software is licensed separately, as set out in the
licenses.

I-4

orin its accompanying license. By continuing, you also agree to those

Installation details

» Visual Studio core editor
» Desktop development with C++
~ Individual components

[<HBRBN< BN <N ]<]

Intel® Fortran Expression Evaluator

Intel(R) Distribution for GDB

Intel(R) oneAPI Debugger Integration

Intel Libraries for oneAP Integration
Intel(R) C++ Compiler Integration 2022
Common tools for Intel compiler projects
Intel® oneAPI Menu & Samples

Fortran IDE

Intel(R) C++ Compiler 2022 MSBuild files
Intel(R) oneAPI DPC++ Compiler Integration
Intel(R) oneAPI DPC++ Compiler 2022 x64 to...

Total space required 0 8

Install while downloading ~ Close

After installation, by launching the installer again, one can see if Visual Studio has been really

installed. You will see “Visual Studio Community 2019” installed.

Visual Studio Installer

Installed  Available

00 Visual Studio Community 2022
1721

Powerful IDE, free for students, open-source contributors, and individuals

Release notes

Da Visual Studio Community 2019
16.11.15

Powerful IDE, free for students, open-source contributors, and individuals

Release notes

Modify
Launch

More ¥

Modify
Launch

More ¥

Developer News

Visual Studio 2022 for Mac is now available
Today, I'm thrilled to share the news of the gener...

2022%5A238

All-In-One Search Is Getting Slicker
Since we first previewed a brand new way to sear...
2022458178

Visual Studio 2022 for Mac Release Candidate 2
Visual Studio 2022 for Mac 17.0 Release Candidat...
2022%5A118

View more Microsoft developer news...

Need help? Check out the Microsoft Developer
Community or reach us via Visual Studio
Support.

Installer version 3.2.2148.26540




Phase II: Install OneAPI (Fortran compiler and its associated libraries)

II-0,
Sign up in the Intel Developer Zone

https://www.intel.com/content/www/us/en/my-intel/developer-sign-

in.html?redirect=https://www.intel.com/content/www/us/en/developer/overview.html

Please keep logged in throughout the processes below.

Free Intel® Software pr X Developer Sign In X Download the Intel oneAPI H

QO B8 nt intel.com,

|nlel PRODUCTS SUPPORT SOLUTIONS DEVELOPERS PARTNERS 8 @UHEREL‘SHJ Q Search Intel.com

Developer Zone

Signin Register
Sign up to get the most out of the Intel® Developer Zone.
Intel Customer or Partner? n N
R for ¢
Username

With a Standard account, you can.

Password » Download development tools and code
+ Post questions to the developer support community

speapand ans 6

By.signing in. you agree to our Terms of Service

» Bookmark content to receive notifications about

updates

Registration is simple and immediate

Forgot your Intel username or password?

Register now for Premier access
Contact customer support n 8 W

A Premier account gives you access to everything
included in Standard access, plus:

» Intel-confidential documentation and tools
+ Pre-release product information

hitps://wwwwintel com/content/www/us/en/forms/developer/standard -registration.htmiPtgt=https//wwwintel.com/content..n/developer/tools/oneapi/base-toolkit-download htmi?operatingsystem=window&distributions=webdownloadBloptions=online |8

II-1
Search “OneAPI BaseToolKit download” or go to

https://www.intel.com/content/www/us/en/developer/tools/oneapi/base-toolkit-

download.html



Free Intel® Software Developr X Download the Intel® oneAPl £ X Download the Intel oneAP| HF

) B hitps intel.com/c

Get the Intel® oneAPI Base Toolkit

The Smart Path to Accelerated Computing without the Economic and Technical Burdens of Proprietary Programming Motiels

Select options below to download

Select operating system

Operating System: Wintlois

Select distribution

DisHilRitich: Online & Offline (recommended)

Select installer

Installer Type: Select here

II-2

Select your OS, Online & Offline, and Online
(If you fail the installation owing to network access instability, please consider choosing

Offline )

Free Intel® Software Developr Download the Intel® oneAPI .- X Download the Intel oneAPI H
C @ Q B8 nt intel.com/c
. Selec ting system i
Operating System: Select operating syster . Online Installer
Windows
= Features customizable installation
« Downloads a small installer file
P, Select distribution
Distribution: Online & Offline (recommended) « Requires an internet connection on the host machine

« Downloads components at the same time as the installation
« Provides an option to create an offline installer

Select installer

Installer Type: Online

What's Included in the Intel® oneAPI v
Base Toolkit for Windows*

Intel® oneAPI Base Toolkit (version 2022.1.3) has been updated to include
functional and security updates. Users should update to the latest version.

Size 13.40 MB
Version 2022.1.3
Date March 03,2022

SHA384 c67fed9ddedeb5abad58ib87ec31ae745alecZb4ad7c97b13ecaled
b433129f735097fe10719c88ffb88c123188f0fa2

II-3

Launch the downloaded installer. Following popup window will show up.



intel Intel® one APl Base Toolkit X

Installer will check your system requirements and launch
automatically. Click Continue to begin.

Software Installer Continue

11-4

Tick “I accept the terms of the license agreements” and click “continue” of “Recommended

Installation” on the right.



intel. Intel® oneAP! Base Toolk

Summary
What's Included Integrate with IDE
Ve = Microsoft Visual Studio*
: 4
Installation Location Required Space
C m Files (x tel\one? D ~

Select your installation mode

[ 1accept the terms of the license agreement
Recommended Installation

Custom Installation

Create a customized offline package for future use

II-5
If you see a warning message below, something is wrong with Visual Studio installation. Please

go back to Phase I.

intel. Intel® oneAP! Base Toolk

Prerequisites Check

pa)

Integrate IDE Software Improvement Program Install
Welcome

Warnings

Intel* Graphics Driver for Windows not found.

You have no relevant GPU driver. If you are going ta develop and run GPU-accelerated applications on this system, please check the installation guide for instructions on the GPU drivers.
Otherwise, you can ignore the warning and continue the installation as is: the product can still be used with CPU.

Intel® oneAPl DPC++/C++ Compiler will not work because none of the supported environments s found on your computer

Intel® oneAPI DPC++/C++ Compiler requires that Microsoft Visual Studio* 2017, 2019 or 2022, or Microsoft Visual Studio Build Tools* 2017, 2019 or 2022 should be already installed and none was
found on your computer. If you select 'Next, Intel® oneAPI DPC++/C++ Compiler will be installed but will not work. Please refer to the Release Notes (nttps://software. intel.com/content /wwiw/usfen/
develop/articles/intel-oneapi-dpc-c-compiler-release-nates.htmi) for details.

II-6
Tick Microsoft Visual Studio* 2019 and click right arrow button on the bottom.



intel. Intel® oneAPI Base Toolkit, v. 2022.2

|
o
X

Installed Products Select Components Modify
Integrate IDE

Would you like to integrate with an IDE? (optional)

Microsoft Visual Studio*
This product can be integrated with the following versions of Microsoft Visual Studio. Select a version to integrate (optional)

[ Microsoft Visual Studio* 2019.
[ Microsoft Visual Studio* 2022

(]

Installation Location
C:\Program Files (x86)\Intel\oneAPI

II-7

Tick whichever you prefer and click “Install” button.

intel. Intel® oneAPI Base Toolkit, v. 2022.2

Welcome Integrate IDE Install
Software Improvement Program

Intel® Software Improvement Program

To improve our software and customer experience, Intel would like to collect technical information about your software installation and runtime status (such as installation metrics, license/

support types, software SKU/serial, counters, flags, and ti and (suchas ing system, CPU i , last 4-digits of the MAC address, 3rd party
API usage and other Intel products installed). ("Information").

Intel may collect this Information directly or optionally through the use of Google Analytics. If Google Analytics is used to collect the Information, Google will aggregate the Information with
that of other users and present the aggregated results to Intel without any personal identifiers. Information collected by Google will be retained by Google under its own data collection
policies (https://support.google.com/analytics/answer/6004245?hl=en).

Information that cannot be linked to an identifiable person may be retained by Intel as long as it is necessary to support the software.

You can revoke your consent at any time by removing the "%LOCALAPPDATA%\Intel Corporation\isip" file. To remove the file, please open a Windows command prompt, go to the folder
"%LOCALAPPDATA%\Intel Corporation\" and delete the "isip" file. If Intel(R) Software Manager is installed on your system, you can also revoke your consent by choosing "Improvement
Program Options" in the "Settings" tab of the Intel(R) Software Manager and selecting the "I do NOT consent to the collection of my Information" option.

For more details, please refer to this article: (https://software.intel.com/en-us/articles/software-improvement-program).

(® | consent to the collection of my information

O 1 do NOT consent to the collection of my information

Installation Location Install =
C:\Program Files (x86)\Intel\oneAPI

II-8

Wait until the progress bars reach the right edges.



intel, Intel® oneAPI Base Toolkit, v. 2022.2 — O x

Welcome Integrate IDE Software Improvement Program et
Instal

Installation in progress

Downloaded 370.8 KB of 2.6 GB 185.4 KB/s

Finalizing removal. It may take up to 5 minutes...

(O Intel® DPC++ Compatibility Tool
Intel® Distribution for GDB*
Intel® oneAPI DPC++ Library
Intel® oneAPI Threading Building Blocks
Intel® oneAPI DPC++/C++ Compiler
Intel® oneAPI Data Analytics Library
Intel* oneAPI Video Processing Library

Intel® Integrated Performance Primitives

Intel® Integrated Performance Primitives Cr

Intel® oneAPI Math Kernel Library

: i o -

II-9

When installation ends, click “Finish” of the popup window.

intel. Intel® oneAPI Base Toolkit, v. 2022.2 |
Welcome Integrate IDE Software Improvement Program
Install
Installation in progress
Downloaded 3.3 GB of 3.3 GB
100%

Process completed

The following tools have been installed successfully:

+/ Intel® oneAPI Base Toolkit, v. 2022.2

[ Open Get Started Guide

Intel® oneAPI DPC++/C++ Compiler

Intel® oneAPI Data Analytics Library Go to Installed Products

v
v
+/ Intel® oneAPI Video Processing Library
v
4

Intel® Integrated Performance Primitives

Intel® Integrated Performance Primitives Cryptography
PAR
2022/05/14

D dx




II-10
Search “OneAPI HPCToolKit download” or go to

https://www.intel.com/content/www/us/en/developer/tools/oneapi/hpc-toolkit-

download.html

II-11
Do the same as BaseToolkit explained above. Below are screenshots during HPCToolKit
installation.

Download the Intel oneARl HP' X

C & 0 & = QO B hit intel.com/cort en/develope 1p t-downlo B8 & i @ @

M= 0= ]maearyrs § BERYATL | scencedirect @) PARIS&TON | 75V, .. R 2021%F (87135 7. (@ Google Agenda - Sem.. @) XTI MR @ XERBUAT. B certitude - traduction ..

Select options below to download

Select operating system

Operating System: Windows v A Download Intel® oneAP| Base Toolkit

This component is part of the Intel® oneAP| Base Toolkit, We recommend that you
i download the full toolkit initially, and then update specific components as needed
Select distribution

Distribidtion: Online & Offline (recommended]

Get It Now

- Select installer
Installer Type: Online v

Online Installer

+ Features customizable installation

+ Downloads a small installer file

« Requires an internet connection on the host machine

« Downloads components at the same time as the installation

« Provides an option to create an offline installer

What's Included in the Intel® oneAPI HPC v
Toolkit for Windows*

Intel® oneAPI HPC Toolkit (version 2022.2.0) has been updated to include functional
and security updates. Users should update to the latest version.

Size 14.10MB
Version 2022.2
Date April 05, 2022

SHA384 €aB89799%ac2653e1c446743b911020dff58b3146f61cb5d3c4025ac8
a4599f07f9f54b38cb2362c4c1b746b27762a%dcf




intel. Intel® oneAPI HPC Toolkit, v. 2022.2 _ o x

Summary
What's Included Integrate with IDE
« Intel® Inspector (2022.1.0) « Microsoft Visual Studio*.

« intei® Trace Anaiyzer and Coliector (2021.6.0)

« Intel® MPI Library (2021.6.0)

« Intel® Fortran Compiler & Intel® Fortran Compiler Classic (2022.1.0)

« Intel® oneAPI DPC++/C++ Compiler & Intel® C++ Compiler Classic (2022.1.0)

Installation Location Required Space
C:\Program Files (x86)\Intel\oneAP| Download size: 184.5 MB
Installation size: 725.1 MB

Select your installation mode

Z | accept the terms of the license agreement

Recommended Installation
Continue
Install everything with commonly used features

Custom Installation
Configure your installation

Create a customized offline package for future use

Software Installer v.4.1.1.0-291

intel. Intel® oneAPI HPC Toolkit, v. 2022.2 _

o
X

Installed Products Select Components Modify
Integrate IDE

Would you like to integrate with an IDE? (optional)

Microsoft Visual Studio*
This product can be integrated with the following versions of Microsoft Visual Studio. Select a version to integrate (optional)

[ Microsoft Visual Studio* 2019.

Installation Location | Chane §
; sl sl 50
CA\Program Files (x86)\Intel\oneAPI ° ° Software Installer v.4.1.1.0-291




intel. Intel® oneAPI HPC Toolkit, v. 2022.2 _ o x

Welcome Integrate IDE Install
Software Improvement Program

Intel® Software Improvement Program

To improve our software and customer experience, Intel would like to collect technical information about your software installation and runtime status (such as installation metrics, license/
support types, software SKU/serial, counters, flags, and ti and i (suchas ing system, CPU i , last 4-digits of the MAC address, 3rd party
API usage and other Intel products installed). ("Information").

Intel may collect this Information directly or optionally through the use of Google Analytics. If Google Analytics is used to collect the Information, Google will aggregate the Information with
that of other users and present the aggregated results to Intel without any personal identifiers. Information collected by Google will be retained by Google under its own data collection
policies (https://support.google.com/analytics/answer/60042457hl=en).

Information that cannot be linked to an identifiable person may be retained by Intel as long as it is necessary to support the software.

You can revoke your consent at any time by removing the "%LOCALAPPDATA%\Intel Corporation\isip" file. To remove the file, please open a Windows command prompt, go to the folder
"%LOCALAPPDATA%\Intel Corporation\" and delete the "isip" file. If Intel(R) Software Manager is installed on your system, you can also revoke your consent by choosing "Improvement
Program Options" in the "Settings" tab of the Intel(R) Software Manager and selecting the "I do NOT consent to the collection of my Information" option.

For more details, please refer to this article: (https://software.intel.com/en-us/articles/software-improvement-program).

(® | consent to the collection of my information

O 1 do NOT consent to the collection of my information

Installation Location Install =
C:\Program Files (x86)\Intel\oneAP

intel. Intel® oneAPI HPC Toolkit, v. 2022.2 _ o x

Welcome Integrate IDE Software Improvement Program ; 1
instal

Installation in progress

Downloaded 184.5 MB of 184.5 MB

Process completed. 100%
The following tools have been installed successfully:

+/ Intel® oneAPI HPC Toolkit, v. 2022.2

0 Open Get Started Guide
Intel® Inspector

Intel® Trace Analyzer and Collector
Go to Installed Products Finish
Intel® MPI Library

Intel® Fortran Compiler & Intel® Fortran Compiler Classic

CAOCKK

Intel® oneAPI DPC++/C++ Compiler & Intel® C++ Compiler Classic

Software Installer v4.1.1.0-291




Phase I1I: Compile PHITS

III-1
Launch Visual Studio

Visual Studio 2019

Open recent Get started
A .
‘ | Al = Clone a repository
Get code from an online repository like GitHub
or Azure DevOps
4 Today
R3] phits-intelsin 2022/l 2o Cl)ﬂ Open a project or solution
C:¥Users¥awago¥Documents¥H5{T¥PHITStest¥compile Open a local Visual Studio project or .sIn file
4 Yesterday
B phits-intel.vfproj 2022/05/23 23:25 @- Open a local folder
C:¥Users¥awago¥Documents¥ & {T¥PHITStest¥compile-omp Navigate and edit code within any folder
m phits-intel.vfproj 2022/05/23 23:24
C:¥Users¥awago¥Documents¥ & {T¥PHITStest¥compile ?kj Create a new project

Choose a project template with code scaffolding

4 This week to get started
m phits.sin 2022/05/18 22:22

C:¥Users¥awago¥Documents¥ 5 {T¥PHITStest¥src

Continue without code >

III-2
From “Open a project or solution”, open /phits/bin/phits-intel.vfproj
If you cannot select it, please make sure that Intel oneAPI appears in Menu

Bar>Tool>Options. If not, oneAPI installation was not successful or you installed Visual

Studio 2022.



DQ File Edit View Git Project Build Debug Test Analyze | Tools | Extensions Window Help  Search (Ctrl+Q) P | phits-intel [ I X

OB WM 9 - -] Debug - x64 o] Intel Compiler |2 Live Share &
Get Tools and Features...

Connect to Database...
co@ade-c @k

Search Solution Explorer (Ctrl+:) P~

Connect to Server...

1 Code Snippets Manager...

Ctrl+K, Ctrl+B

& Solution 'phits-intel’ (1 of 1 project)
4 @ phits-intel (IFORT)
> Ml Header Files
Ml Resource Files
> M Source Files

Choose Toolbox items...

X0q|00)  1310]dx3 Joniag

NuGet Package Manager

Create GUID
Error Lookup

Spy++

External Tools...

Command Line

import and Export Settings...

Customize...

£+ Options... Solution Explorer [RCIaEI

Properties
tel Project Properties
Output noF

Show output from:  File Generation SlEle =S|

(Name) phits-intel
Project Path C:¥Users¥awago¥Documents¥#51T7Y

Projects loaded and ready to use 5

Background tasks are still running (Name)

Name of the project.

Aliasignoie

Optimization Report

[ Parse file c:¥users¥awago¥documer T¥phitstest¥src¥egsSelast.f A Add to Source Control ~ A

Options ? X

= 4

Search Options (Ctrl+E) L FPGA Settings
Board packages:

> Environment

bProjects and Solutions Installed board packages:

Source Control No board support package installed.
>Work Items Board packages shipped with Intel(R) FPGA SDK for OpenCL(TM): (for report
P Text Editor

generation/emulation/runtime use only) :

> Debuggin
22 intel_a10gx_pac: C:¥Program Files (x86)¥Intel¥oneAPI¥compiler¥2022.1.0

b Performance Tools

> CMake ¥windows¥lib¥oclfpga¥board¥intel_a10gx_pac (default)
P Database Tools intel_s10sx_pac: C:¥Program Files (x86)¥Intel¥oneAPI¥compiler¥2022.1.0
b Graphics Diagnostics ¥windows¥lib¥oclfpga¥board¥intel_s10sx_pac

P Intel Compilers and Libraries
4Intel oneAPI
FPGA Settings
Intel® Distribution for GDB*
Samples
PIntelliCode
PLive Share
P NuGet Package Manager
bTest

b Tact Adantar far Ganala Tact

Documentation about board packages

oK ‘ Cancel

III-3

Create an executable file by

Build > Build Solution

In Windows, please see “Execute via Command Prompt” in the manual on how to launch the

executable file.



Build | Debug Test Analyze Tools jons  Window Help | Search (Ctrl+Q) P | phitsintel [ I X
1% Build Solution Ctrl+Shift+B _ & lveshare &
Rebuild Solution -

b File Edit View Git Project
cro|lB-zRM| 9

Clean Solution

Run Code Analysis on Solution Alt+F11

coadlo-oa| s

Search Solution Explorer (Ctrl+:) P~

Build phits-intel (IFORT) Crl+B
Rebuild phits-intel (IFORT)
Clean phits-intel (IFORT)

Project Only

223 Solution ‘phits-intel’ (1 of 1 project)
4 [A phits-intel (IFORT)
> Ml Header Files
Ml Resource Files
> Ml Source Files

Batch Build...

Configuration Manager..

Output

Show output from:  File Generation = s =

(Name) phits-intel
Project Path C:¥Users¥awago¥Documents¥#51T7Y

(Name)
Name of the project.

Compiler Optimization Report

Compiler Inline Report

A

A Add to Source Control «

11-3’

To use OpenMP, activate “Qopenmp” option from

Menu bar > Project > Properties > Fortran > Language > Process OpenMP directives >

Generate Parallel code

D Fle Edit View Git | Project | Build Debug Test Analyze Tools Extensions Window Help  Search (Cir+Q) P | phits-intel e - o X
Ov0|a‘3v‘*.ﬂn“ _ 2 LiveShare &

Add New Item...
‘0 Add Existing Item...

Ctrl+Shift+A
Shift+Alt+A

Solution Explorer
cogd e-2a|”

Search Solution Explorer (Ctri+) R ~

Add Existing Items From Folder...

New Folder

Jolo|dx3 JonIBS

Unload Project
7 Solution ‘phits-intel’ (1 of 1 projec
“ phits-intel
> M HeaderFiles

M Resource Files
> o Source Files

Set as Startup Project
Export Template.

X0qjoo].

Manage NuGet Packages...

Properties

Properties v X
phits-intel Project Properties ”

Output X
p [T ot intel
& E

Show output from: File Generation ProjectPath  C:¥phits¥bin¥

(Name)
Name of the project.

Compiler Optimization R

Add to Source Control «

i



0¢) Fle Edit View Git Project Buld Debug Test Analyze Tools Extensions Window Help | Search (Ctrl+Q) P phits-inte [} - O

OB -2 M| 9| pebug - 86 - b st v | B | @ & liveShare &

@@ o-cal|”

Configuration: | Active(Debug) | Platform:  Active(Win32) v | | Configuration Manager. Search Solution Explorer (Ctrl+) R ~

[ Solution ‘phits-intel' (1 of 1 projec]
“ phits-intel

> M Header Files

M Resource Files

> M Source Files

4 Configuration Properties Source File Format Use File Extension
General Fixed Form Line Length 72 Columns
Debugging Pad Fixed Form Source Lines No
4 Fortran Enable Alternate PARAMETER Syntax Yes

General Enable FORTRAN 66 Semantics ~ No
Optimization Compile Lines With D in Column 1 No
Debugging Generate Parallel Code (/Qopenmp)
Praeassar Enable F2003 Semantics Disable
Code Generation Enable Coarrays Generate Parallel Code (/Qopenmp)
e MPI Configuration File Generate Sequential Code (/Qopenmp_stubs)
Compatibity Coarray Images <inherit from project defaults>

xoqj001 siojdg sonias [

Diagnostics
Data »
Floating Point ce Navi.. [T 5P
External Procedures
Output Files Properties 2 g
Run-time its-intel Project Properties -
Libraries LA
Command Line

OUpLL b Linker

Process OpenMP Directives (Name) phits-intel
Enables the compiler to generate multi-threaded code based on the OpenMP directives. (/Qopenmp, Project Path  C:¥phits¥bin¥
/Qopenmp-stubs)

Show output from:  File Generation b Resources
| b MIDL

oK *rvel ERPR)

Name of the project.

ints JOUGY Compiler | ompiler Optimization Report

4 Add to Source Control « &

11-3”

11-37-1

To use MPI, you need to
e Install MS-MPI (not explained in this manual. Please search “MS-MPI install”)
e Configure the Build of Visual Studio

To configure the Build of Visual Studio, close Visual Studio and open phits¥bin¥phits-
intel.vfproj with a text editor (e.g. notepad++). Then replace a line

<File RelativePath="..¥src¥mpi-non.f"/>

with

<File RelativePath=".. ¥src¥mpi-win.f"/>

and save, open phits¥bin¥phits-intel.vfproj with Visual Studio again.

II1-37-2
Add a library file msmpi.1ib

Menu bar > Project > Properties > Linker > Input > Additional dependencies



phits-intel Property Pages ? X

Configuration: ‘Active(Debug} x4 ‘ Platform: |Active(Win32] v ‘ ‘ Configuration Manager...
4 Configuration Properties | Additional Dependencies [ i) [~]
General Ignore All Default Libraries No
Debugging Ignore Specific Library
I Fortran Module Definition File
4 linker Add Module to Assembly
General Embed Managed Resource File
Input Force Symbol References
Manifest File Delay Loaded DLLs
Debugging
System
Optimization
Embedded IDL
Advanced

Command Line
I> Resources
> MIDL
P Manifest Tool
I Build Events
> Custom Build Step

Additional Dependencies
Specifies additional items to add to the link line (ex: kernel32.lib); configuration specific.

oK H vt || ERW)

I1-37-3



